comStation

Installation Guide

Zydacron P/N: MA40077-ENG, Rev. D

Tutelligent Meeting Sotutions August, 2001



comStation Installation Guide

Copyright, ® 2000 - 2001 by Zydacron, Inc.
Zydacron, Inc.

7 Perimeter Road

Manchester, NH 03103 U.S.A.

Telephone: (603) 647-1000
Fax: (603) 647-9470
Website: www.zydacron.com

PROPRIETARY RIGHTS NOTICE: All rights reserved. No part of this material may be reproduced or
transmitted in any form or by any means, electronic, mechanical, or otherwise, including photocopying and
recording or in connection with any information storage or retrieval system, without permission in writing from
Zydacron, inc.

comStation™ and comStation 2000™ are Trademarks of Zydacron, Inc.
Microsoft Windows NT® and Windows 2000® are Registered Trademarks of Microsoft Corporation
VELCRO® is a registered trademark of Velcro industries B.V.

All Brand and product names are recognized as trademarks™ or registered trademarks® of their respective
companies.

Printed in the United States of America.

ZYDACRON EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE SHALL ZYDACRON BE LIABLE FOR ANY
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, WHETHER FORESEEABLE OR
UNFORESEEABLE, THAT RESULT FROM THE USE, THE INABILITY TO USE, OR THE INSTALLATION OF
THE ZYDACRON SOFTWARE AND/OR HARDWARE.

If the Zydacron Software to be furnished under this contract is to be supplied to the Department of Defense
(DoD) of the United States Government, the Software is classified as "Commercial Computer Software” and the
Government is acquiring only "restricted rights" in the Software and its documentation as that term is defined in
Clause 252.227-7013(c)(1). If the Zydacron Software is supplied to any unit or agency of the United States
Government other than the DoD, the Government's rights in the Software and its documentation will be as
defined in clause 52.227-19(c)(2) of the FAR or, in the case of NASA, in Clause 18-52.227-86(d) of the NASA
Supplement to the FAR.

Warning: Opening or making changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user's authority to operate the equipment and will void the
warranty.



comStation Installation Guide

Table of Contents

Important Safefy INfOrMAatioN ... rreressin e s e mesermsrasensessnmuans s saRe svearasts srramans smnsssesnses 4
Ordering ISDIN SEIVICE .....cociccicecr et et e e s s s s e ss e e et e smbsaeaseatesarab s s s beR s e bt sasara bt a s ia et s eres 4
CUSTIOMEBE SUPPOM........coireieeicricrree e e et s bbb s 4 e e e ae s s e s sees et sesbeees s s bb s e s e a s sesasanrsab e sannnabenes 4

camStation Setup......c.... HaRERReaEaRERasuRaUnrnretnnRRSRSEEENENEEE R EREERREEEROE LR e rann o e e mmeeLeReesEe b PeR AR e R ARt Satans sama nnnren 5
comStation [P INStAlAHON PIOCBAUIE ..........cccvieiciees et e e se s s e sresa st b s ste st st e e sans s vmeneesnereanseansssaen 8
comStation 512 INStallation ProceaUIe ... ittt eeeee e e eeesereeseeesseenneeeenen 10
comStation V.35 Installation ProCeaUre ...t ee e ees 12
Connecting Zydacron comStation ComMPONENES ..........vvieirieeieeieece s sas e s e s rnstonor camsssresras 14
SEttNG UP the NEIWOIK. ...ttt ettt reas st e s s et st e eeneneee et s e eameemnassmemeansaneneseneeen 14
StliNG UD NBIMEBHING. ...t e bbbt e e e ee e eeneemn e s e e ameaeaesseesemnsmnennsaenneas 16

Software Recovery.........ccrecenrrcnnsnnnns . S wemmmreeserenemesnammamseeess 17
Setting Up the Video CONfIQUIation ...............c.oo ittt erte s e s esseest s sae s e seeeeeessaeesaesevsseesesnees 17
Configuring the AULIO QIUEDUL ... et st e e e se e s e re st s be et sara bt st e e ss s seebemememnea 18
USING The ATIM TOO ...ttt s e e e e e v es st e e seeeme et ensmeesasestesaeasnsesseesmen s st smtesannteeeeeememmeemns 19

Technical SPECIFICAIONS .uiiciiiisiine e rrccrretrsissemsesssms s seermesmean e smeassnaesr sE AR RN A e e sm e s mmms semsmsmsasamrasassamassnsan 20

T T 23

Send Us YOUFr COMMENLS ...........oeocererrrerssseresasamrnmessmssrssnnssss ssssmsennes ssmenensssnmmenssssemmennnasasesese .24




comStation Installation Guide

Important Safety Information

WARNING: Potential Shock Hazard ﬁ
¢ Only experienced and qualified technicians should install the comStation,

* Install comStation in a safe location where no one can step on, trip over, or damage the
cables.

* Always use properly grounded electrical outlets.

* If you need to use an extension cord, make sure it is rated to handle more current that the components it is
powering.

» Always disconnect power before attempting to clean or service comStation or any components.
» Do not use liquids to clean comStation or any components.

* Keep all electronics away from water, extreme heat, or direct sunlight.

» Do not install or use this product near water.

¢ Keep vents free of obstructions.

* Always follow basic safety precautions when using this product to reduce risk of injury from fire or electric
shock.

¢ Keep all electronic components away from children.

¢ Do not disassemble this system (except as instructed in the manufacturer's instructions). To reduce the risk
of shock and to maintain the Warranty on the system, only qualified, experienced technicians may perform
service or repair work.

SAVE THESE INSTRUCTIONS.

Ordering ISDN Service

For more information about ordering ISDN service, refer to the document:
How to Order ISDN for Zydacron Products. This PDF document is available at www.zydacron.com.

Customer Support

For comStation support, contact your Zydacron reseller.

To test your system, call the Zydacron Test Station: 1 + (603) 644-6950. Zydacron provides the test station to
test your videoconferencing setup. It can be called at 2 x 64k {dial the same number twice) or one channel up to
384k. A successful connection to the Test Station provides you with the test station’s video and audio.

You can also visit the Zydacron website, www.zydacron.com, for information on the latest product offerings.
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comStation Setup

The exact installation procedure for your comStation depends on which model you have. Refer to the table
below.

Type of comStation | Primary Features Page
comStation IP | Z360 codec 8
comStation 512 | Z360 codec, ZC208 IMUX Board 10
comStation V.35 | Z360 codec, V.35 Board 12

Each model comes with a Personal Computer, Shure Microphone, Canon Pan/Tiit/Zoom Camera, Wireless
Keyboard with Mouse and Infrared Receiver, and Cables.
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Identifying Standard Components

Unpack the computer, wireless keyboard, and camera and refer to the documentation provided.

Cables
Identify the cables pictured below:

# Description Color
1 | CB-1091-000 (DB15) Black
2 Camera Audio In White
3 Video In #1 Green
4 Video In #2 Yellow
5 Video QOut Blue
6 Video Out Blue
7 Vidao In #3 Red

CB-1091-000 Video Breakout Cable

# | Description Color

1 | CB-1092-000 (DB26) Black

2 | Audio In#1 White

3 | Audio In #2 White

wmfm 4 | Aux Audio In White
Tk 5 | Audio Out Orange
- . 6 | Aux Audio Cut Orange

7 7 | Microphone #1 Silver

— 8 | Microphone #2 Silver

c 9 | Headset Green

.. EEERRY o 10 | Speaker Qut Black

10
CB-1092-000 Audio Breakout Cable
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Camera
Identify the Canon VC-C4 Camera pictured below:

# | Description

1 DC IN 13V

2 | SVIDEOQ OUT
3 | RS232C-IN

Canon VC-C4 Camera Rear View

Microphone

identify the Shure Microphone pictured below:

Shure Microphone, Top View
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comStation IP Installation Procedure

Refer to the Identifying Standard Components section, starting on Page 6 as needed. Complete the following
steps to setup your comStation 1P:

1. Identify the comStation [P Computer Rear Panel (shown below).
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Description

2360 Codec Endplate

Codec Video Connector

Codec Audio Connector

Serial 2 Jack (RS232)

Audio Board Line In Jack (Blue)

Audio Board Audio Output Jack {Green)
-8 Keyboard (Purple) & Mouse (Green) Jacks
Network interface Card (LAN) Connector
Computer AC Power Jack
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comStation IP Computer Rear Panel

2. Locate the Z360 Codec Endplate on the back of the computer (shown above).

3. Plugin the large (DB15) connector of the CB-1091-000 Video Breakout Cable in the bottom Codec Video
Connector of the 2360 Codec Endplate.

4. Plug in the large (DB26) connector of the CB-1092-000 Audio Breakout Cable in the top Codec Audio
Connector of the Z360 Codec Endplate.
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10.

11.

12.

13.

14.

15.

Unpack the Canon Camera and refer to the Canon documentation as needed.

Piug the 8-Video cable into the S-Video Jack on the Canon Camera. Plug the free end of this cable into the
Video In #1 Jack {green) on the CB-1091-000 Video Breakout Cable.

Plug the small connector on the PA10073 Cable (gray) into the R8232C jack on the Canon Camera. Plug
the free end into the Serial 2 Jack (RS$232) on the computer.

Plug the Canon Camera Power Supply Cable to the DC IN 13V Jack on the Canon Camera. Insert the AC
Line Plug into a suitable power outlet.

Attach the Shure Microphone to the Microphone #1 XLR jack on the CB-1092-000 Audio Breakout
Cable.

Attach one mini-plug connector of the CB-1077-000 Audio Cable into the Speaker Out Jack on the CB-
1092-000 Audio Breakout Cable. Attach the other mini-plug connector into the Audio Board Line In Jack
(blue) on the computer's Audio Board End Plate.

Plug (optional) amplified speakers into the Audio Board Audio Output Jack (green) on the computer's
Audio Board End Plate. You can alsc plug an optional headset into the Headset Jack on the CB-1092-000
Audio Breakout Cable.

Attach the Infrared Receiver for the Wireless Keyboard to the computer or optional cart as desired using
the Velcro® tape provided. Make sure that the IR Receiver is facing the front because the wireless
keyboard operates using infrared light similar to a TV remote control.

Plug the Infrared Receiver Cable into the Mouse and Keyboard Jacks on the back of the computer. Note
the mouse and keyboard symbols on the connectors.

Aftach your LAN cable to the Network Interface Card (LAN) connector. Make sure the LAN cable is
connected to your Local Area Network.

Insert the computer’'s AC Power Cable into the Computer AC Power Jack located on the left side of the
computer’s back panel and then to a suitable power outlet.
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comStation 512 Installation Procedure

Refer to the Identifying Standard Components section, starting on Page 6 as needed. Complete the following
steps to setup your comStation 512:

1. Locate the 2360 Codec Endplate on the back of the computer as shown below.
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Description

Z360 Codec Endplate

Codec Video Connector

Codec Audio Connector

Serial 2 Jack (RS232)

Audio Board Line In Jack (Blue)

Audio Board Audio Output Jack (Green)
Keyboard (Purple) & Mouse (Green) Jacks
Network Interface Card (LAN) Connector
Computer AC Power Jack

ISDN Port 1, ZC208 Card Endplate
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comStation 512 Computer Rear Panel

10
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10.

11.

12.

13.

14,

Plug in the large (DB15) connector of the CB-1091-000 Video Breakout Cable in the bottom Codec Video
Connector of the Z360 Codec Endplate.

Plug in the large (DB26) connector of the CB-1092-000 Audio Breakout Cable in the top Codec Audio
Connector on the Z360 Codec Endplate.

Unpack the Canon camera and refer to the Canon documentation as neaded.

Plug the $-Video cable into the S-Video jack on the Canon camera. Plug the free end of this cable into the
Video In #1 jack {green) on the CB-1091-000 Video Breakout Cable.

Plug the small connector on the PA10073 Cable (gray) into the RS232C jack on the Canon camera. Plug
the free end into the Serial 2 Jack (RS232) on the computer.

Plug the Canon Camera Power Supply Cable to the DC IN 13V Jack on the Canon camera. Insert the AC
Line Plug into a suitable power outlet.

Plug the optional CB-1056-000 ISDN Cable or equivalent into ISDN Port 1 located on the computer rear
panel. (Port 1 is labeled on the ZC208 Card Endplate on the computer rear panel.) Attach the free end to
your ISDN network. Plug additional ISDN cables as desired into Ports 2, 3, and 4 in the same fashion. (Four
cables are required for 512 Kbps transmission speed.)

Attach the Shure Microphone to the Microphone #1 XLR jack on the CB-1092-000 Audio Breakout
Cable.

Attach one mini-plug connector of the CB-1077-000 Audio Cable into the Speaker Out Jack on the CB-
1092-000 Audio Breakout Cable. Attach the other mini-plug connector into the Audio Board Line In Jack
(blue) on the computer's Audio Board End Plate.

Plug (optional) amplified speakers into the Audio Output Jack (green) on the computer's Audio Board End
Plate. You can also plug an optional headset into the Headset jack on the CB-1092-000 Audio Breakout
Cable.

Attach the Infrared Receiver for the Wireless Keyboard to the computer or optional cart as desired using
the Velcro tape provided. Make sure that the receiver is facing the front because the wireless keyboard
operates using infrared light similar to a TV remote control.

Plug the Infrared Receiver Cable into the Mouse and Keyboard Jacks on the back of the computer. Note
the mouse and keyboard symbols on the connectors.

Insert the computer's AC Power Cable info the Computer AC Power Jack located on the left side of the
computer's back panel and then to a suitable power outlet.

1"
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comStation V.35 Installation Procedure

Refer to the Identifying Standard Components section, starting on Page 6 as needed. Complete the following
steps to setup your comStation V.35:

1. Locate the Z380 codec endplate on the back of the computer as shown below.
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Description

Z360 Codec Endplate

Codec Video Connector

Codec Audio Connector

Serial 2 Jack (RS232)

Audio Board Line In Jack (Blue)

Audio Board Audio Output Jack (Green)
Keyboard {(Purple) & Mouse (Green) Jacks
Network Interface Card (LAN) Connector
Computer AC Power Jack

V.35 Jack, V.35 Card Endplate
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comStation V.35 Computer Rear Panel
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10.

11

12.

13.

14.

Plug in the large (DB15) connector of the CB-1091-000 Video Breakout Cable in the bottom Codec Video
Connector of the Z360 Codec Endplate.

Plug in the large (DB26) connector of the CB-1092-000 Audio Breakout Cable in the top Codec Audio
Connector on the Z360 Codec Endplate.

Unpack the Canon Camera and refer to the Canon documentation as needed.

Plug the §-Video cable into the S-Video Jack on the Canon Camera. Plug the free end of this cable into
the Video In #1 Jack (green) on the CB-1091-000 Video Breakout Cable.

Plug the small connector on the PA10073 Cable (gray) into the RS§232C jack on the Canon Camera. Plug
the free end into the Serial 2 Jack (RS232) on the computer rear panel.

Plug the Canon camera Power Supply Cable to the DC N 13V Jack on the Canon Camera. Insert the AC
line plug into a suitable power outlet.

Attach the Shure Microphone to the Microphone #1 XLR jack on the CB-1092-000 Audio Breakout
Cable.

Attach one mini-plug connector of the CB-1077-000 Audio Cable into the Speaker Out jack on the CB-
1092-000 Audio Breakout Cable. Attach the other mini-plug connector into the Line In jack (blue) on the
computer's Audio Board End Plate.

Plug (optional) amplified speakers into the Audio Output Jack (green) on the computer’'s Audio Board End
Plate. You can also plug an optional headset into the Headset jack on the CB-1092-000 Audio Breakout
Cable.

. Attach the CB-1020-012 or CB-1020-013 V.35 Cable (or equivalent) into the V.35 Jack on the computer

rear panel.

Attach the Infrared Receiver for the Wireless Keyboard to the computer or optional cart as desired using
the Velcro tape provided. Make sure that the IR Receiver is facing the front because the Wireless Keyboard
operates using infrared light similar to a TV remote control.

Plug the Infrared Receiver Cable into the Mouse and Keyboard Jacks on the back panel of the computer.
Note the mouse and keyboard symbols on the connectors.

Insert the computer's AC Power Cable into the Computer AC Power Jack located on the left side of the
computer's back panel and then to a suitable power ouflet.

13
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Connecting Zydacron comStation Components

Dual Microphones

Connect an optional second Shure microphone (if desired) to the Microphone Input 2 Jack on the CB~1092-
000 Audio Breakout Cable. Position the second microphone near the ceiling or at the far end of the conference
table. NOTE: To use configure your software for dual microphone operation, from the Tools menu, select
Controls, then select the Audio Controls tab. Select Configure, then select Dual Mic.

Wireless Keyboard/Mouse

Install the AA batteries included with the Zydacron comStation into the battery holder, which is accessed
through the bottom of the keyboard. Be sure to observe polarity.

Remave all packaging from the infrared transmitter located on the front of the keyboard.

You have now completed the hardware setup for comStation. Before power up, verify that all cable connections
are secure. Refer to the comStation User's Guide for further information.

Setting Up the Network

From the Windows desktop select Start > Programs > comStation > Network Setup. Selecting ISDN starts
the ISDN network setup. Selecting LAN starts the LAN network setup. Selecting ISDN and LAN starts the
LAN network setup first, then the ISDN network setup.

LAN Network Setup (H.323)
Complete the Configure Gatekeeper dialog box as follows:

1. Ask your network system administrator for the information needed to complete the fields in this dialog
box.

2. If your system is not using a Gatekeeper, do nof check the Use Gatekeeper checkbox. If your system
has a pre-configured Gatekeeper do nof check the Use Gatekeeper checkbox. Click the OK button to
complete the LAN network setup.

If your system is using a Gatekeeper, ask your network administrator for your system’s name and
phone number. If you are using only IP addressing, complete these steps:

= Use Gatekeeper: Check here to use Gatekeeper.
» IP Address: Enter the IP address of your Gatekeeper system.
* Name: Enter a unique name. This is the name others on your network will use to call you.

+ Phone Number: Enter a unique telephone number. This is the number others on your network
will use to call you. Network administrators typically assign these.

ISDN Network Setup (H.320)
To complete the Network Setup Wizard, follow these steps:

1. Select the Switch Software that is configured for your ISDN phone line from the list, then click the
Next> button. (Contact your ISDN service provider for this Switch Software information.} The Network
Setup Wizard displays the If you have MSN... message.

2. Click the Next> button to continue. If your switch type is NI1, DMS100, AT&T5ESSA, or G3 Custom,
the Network Setup Wizard displays the You have specified a switch... message. This dialog box is
where SPIDs are specified.

3. Enter the SPIDs in their corresponding fields. If you have only one SPID, enter it in SPID 1 and leave
SPID 2 blank. (You may have up to four pair of SPIDs depending on your setup.) The settings do not
take effect until you restart your computer. Click the Next> button to continue.

14
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10.

Configure the Subscriber and Dialing information using the following descriptions:

e MBSN - Check this box if you have a Multiple Subscriber Network. If you are unsure, leave this box
unchecked.

¢ Parallel Dialing - Check this box if you want to allow multiple simultaneous call dialing. This would
speed the connection process. Not all manufacturers are IMUX compatible with paraliel dialing. If
you are unsure or unable to connect to a site, uncheck the Parallel Dialing box.

¢ Internal Dialing Preflx — Enter a dialing prefix if your company uses one. Prefixes are typically
required with PBXs. The Network Setup Wizard uses this prefix setting to perform a Loopback
Test.

= Phone Number - Enter a voice phone number. Dialing 1 + the area code may also be required to
access a POTS (Plain Old Telephone Service) line. The Network Setup Wizard uses this phone
number to test the voice capability of your ISDN line(s). You must run the voice only test to make
voice calls. Leave the phone number field blank if voice-only call capability is not required.

Click the Next> button to continue. The B Channel Entry dialog box displays.

Enter the ISDN Phone Number for the B Channel. (You may need to enter up to eight numbers
depending on your sefup.)

If you entered a dialing prefix in the Subscriber and Dialing dialog box, do notf enter that prefix as part
of the phone number here. Incorrect phone numbers could cause the Network test to fail.

For NI1, and DMS100 switch types there are two different numbers per interface. Enter those numbers
in order, starting with B Channel 1 followed by B Channel 2, etc.

For other switch types, enter the same phone number in both B Channels. (The settings do not take
effect until your computer is restarted.)
Click the Next> button to continue. The Start the Network Setup Test dialog box displays.

NOTE: Certain switch types do not allow for B Channel testing. If the B Channel test fails, wait for it to
time-out then click the Finish button.

Click the Next> button to start the Network Setup Test. The Network Setup Wizard ISDN Test dialog
box displays. The automatic ISDN line anaiyzer tests your ISDN line. This process lasts for
approximately three minutes. If your system fails the network test, readjust the settings and rerun the
test. Upon successful test completion, click the Next> button. The Network Setup Wizard displays the
ISDN Line Analyzer dialog box.

The Automatic ISDN Line Analyzer tests your ISDN line. If your system does not pass the Network
Test, adjust the settings and rerun the test. The most common reasons for test failure include:

* Incorrect Phone number
» Incorrect SPIDs

To correct the network configuration, click the <Back button to return to a previous dialog box and
correct the error.

Click the Finished button in the Network Test Compilete dialog box to finish the network test
procedure. The Setup Complete dialog box displays.

15



comStation Installation Guide

Setting Up NetMeeting

Microsoft NetMeeting can establish a data conference over an existing video call. After installing NetMeeting

and rebooting or starting the application, the NetMeeting Wizard starts. To set up NetMeeting, follow these
steps:

Follow the Microsoft NetMeeting Wizard and click the Next button to continue.

Make sure that the Directory Server checkbox is UNchecked and click the Next button to continue.
Complete the NetMeeting User Information form and click Next to continue.

Select the User Category and click the Next button to continue.

Click the Finish button.

Refer to NetMeeting Help for more information.

O ;s W N
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Software Recovery

Refer to the Software Recovery Disk Procedure document provided with your comStation. After completing a
software recovery, proceed to Sefting Up the Video Configuration below.

Setting Up the Video Configuration

The first time you start the comStation application after installation, the Video Setup Wizard automatically
displays. (You can also run the Video Setup Wizard at any time by selecting Controls from the Tools menu.
Click on the Video Controls tab > Video Setup Wizard button.) To configure the video, follow these steps:

1. Select the video format, NSTC for North and South America, Japan, South Korea, Philippines, and Taiwan

and PAL for Europe, Asia, and Africa. The Video Setup Wizard starts by displaying the Video Format
dialog hox.

Click the Next> button to continue. The Video Setup Wizard displays the Video Input dialog box.

3. Configure the Video Input: 1 by entering the following information:
» Usage: Select the Main Camera. The Usage appears as a menu item or button name.

» Name: Enter a unique name. This Name appears on far end systems if you check the Allow far end
camera selection checkbox. (Default is Input 1.)

» Model: Select the camera brand and model. This sets the defaults properly for known camera types,
including computer controlled pan-tilt-zoom controls. The Zydacron reseller set the options available.

* Allow far end camera selection: Check this box to allow for FECC (far end camera control). Your
camera model must have remote control capability and the far end system must be H.281 compliant.

4. Click the Next> button to continue. The Video Setup Wizard displays the Video Connector dialog box
(shown below).

Note: The Video Connector dialog box will not display if Video Input: 3 is selected.

3 Yideo Setup Wizard

Video Setup Wizard

5. Selecting a specific camera model in the Video Setup Wizard automatically selects the correct connector
type for your camera (See figure above). You can also manually select the type of video input connector:
» Composite uses an RCA connector, like the one shown at the top of the Video Setup Wizard (above).

» S-Video typically uses a DIN connector, like the one shown at the bottom of the Video Setup Wizard
{above). (S-Video can also be converted from an RCA connector by using an RCA-DIN adapter.)

¢ Not Sure is if you are unsure of which connector to use.

17
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6. Click the Next> button to continue. If you have more video inputs, set them up using the same method as
described above and click the Next> button to continue after each one.

The Video Setup Wizard displays the Live Video dialog box. You should see a small image of your /ocal
video signal disptay within the wizard as shown.

7. Select the video inputs that you configured earlier. Verify that you can see video from that source. If the
displayed video is black and white (it should be in color), you may have incorrectly selected 8-Video as your
video connector. You can use the <Prev button to return and change that selection now. (You can also run
the Video Setup Wizard at any time by selecting Controls from the Tools menu. Click on the Video tab.)

8. Click the Finished button. The comStation Software displays the Main Video window (below). The Main
Video Window displays live video. This live video allows you to see how you will look to the viewer on the
far end before you make a call. This is the best time to focus your camera and/or adjust lighting. (The sound
may not be audible yet. This is normal.)

" Not in a call : =10 x|

Eile Phone Yiew Tools Hsip

| 30B:04PM |

P H iNotin a call
B

Main Video Window

Configuring the Audio Output

The first time you run the comStation application, you must configure and verify the Audio Output. Go to
Tools > Controls > Audio Controls tab and run the Audio Auto Select. The comStation should normally be
set to Input Mic and Output Speaker.

18
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Using the ATM Tool

ATM support requires installation of the following Fore Systems Software:
e ForeThought 5.0.2 Build 33861

= ForeThought 5.0.2 Winsock Service Provider Build 33861

To obtain this software contact Fore Systems (www.fore.com).

Zydacron recommends using bit rates greater than 120 KB. You may need to adjust the minimum bit rate
based on your system requirements. Use the ATM Tool program (atmtool.exe) to adjust the Quality of
Service (QOS) class and minimum bit rate of your system.

Acceptable QOS Classes are:

Unspecified bit rate* Use UBR for bursty LAN traffic and data that is more tolerant of delays and cell
(UBR). loss. UBR is a best effort service that does not specify bit rate of traffic
parameters and has no quality of service guarantees.

Real-ime variable RT-VBR has a bursty nature. Voice and video applications that use compression.
bit rate* (RT-VBR).  Traffic is real-time, where end-to-end delay is critical in applications such as

videoconferencing.
Non real-time VBR-NRT has a bursty nature and is characterize by voice of video applications
variable bit rate* that use compression. Traffic is non-real time, where delay is not critical.
(VBR-NRT). Examples include applications such as video playback, training tapes, and video
mail messages.
Available bit rate* LAN traffic and data that is more tolerant of delays and cell loss uses ABR. ABR
(ABR). is a best-effort service base on minimum cell rate with a low cell loss.
Constant bit rate* A continuous stream of bits at a steady rate characterizes CBR traffic. CBR traffic
(CBR). is low-bandwidth traffic that is highly sensitive to delay and intolerant to cell loss.

This is the default QOS class.
*If supported by the ATM NIC.

Modifications to the QOS class require that you restart the application. Modifications to the minimum bit rate
require that you hang-up and redial your existing connection.

NOTE: If your computer does not have an ATM card installed, the ATM Tool Menu will display, but all options
will be grayed-out and non-functional.
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Technical Specifications

‘*Tai‘t i
Audio Compression

"G.711, G.728, G.722

Audio Inputs One Line Level input on the CB-1092-000 cable
Two auxiliary inputs on the CB-1092-000 cable
2 Balanced microphone inputs on the CB-1092-000 cable
Audio Outputs Speaker output on stereo 3.5mm jack for Line Level on the CB-1082-000 cable

Two auxiliary outputs on the CB-1092-000 cable

RJ-11 phone interface

RJ-11 jack to connect a standard POTS telephone for privacy.
Hook and DTMF generation.

Echo cancellation

ot
Video Compression

Full duplex echo cancellation
Disable and enable cancellation
matic Gain

o H.261, H.263
Video Resolution and + H.261: CIF resolution 352 x 288 — Encode 30fps, Decode 30fps
Frame Rates = H.261: QCIF resolution 176 x 144 - Encode 30fps, Decode 30fps
+ H.263: CIF resolution 352 x 288 - Encode 15fps, Decode 30fps
+ H.263: QCIF resolution 176 x 144 - Encode 15fps, Decode 30fps
Video Inputs + Composite Video or S-Video input #1 on the CB-1091-000 cable
s Composite Video or S-Video input #2 on the CB-1091-000 cable
+ Composite input #3 on the CB-1091-000 cable
« Brightness, contrast, saturation, and hue controls
o Capture of full resolution image 640x480 (NTSC) or 768x576 (PAL) square pixels
VGA Display e PClbus S-VGA boards that supply Direct-Draw Drivers and linear addressing

for the frame buffer
VGA board must support 16-bit color at 800x600 resolution.

Main Video Window

¢ View incoming video

View outgoing video, encoded then decoded, for self-view of what remote side
sees

« Smooth scaling from icon to 640x480
¢ Maintains proper aspect ratio
s PIP of camera view optional
e 640 x 480 (interlaced) maximum size with one video window {with PIP).
Self-View picture-in- * View camera input
picture Window » Location in one of 4 corners of main window
+ Small, medium, and large sizes
Communications = .
Protocols « H.320, H.323, H.221, H.230, H.242, H.243
Rates « |SDN: 56Kbps to 512Kbps
¢ LAN — speeds up to 768Kbps
+ V.35 —speeds up to 1680/1920 Kbps
ISDN Network + |SDN BRI Signaling
Termination
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S/T Network Termination | « 5ESS = D-Channel signaling for AT & T 5ESS
on ZC206/ZC208 » 5ESSA » _D-Channel signaling for North America with SPIDs
» G3 Custom e D-Channel signaling for Lucent Difinity PBX switch
* NI1 ¢ D-Channel signaling for National IS DN-1
» DMS100 » D-Channel signaling for NT{ DM S100
+ EURO + D-Channel signaling for European ISDN
* 1TR6 ¢ D-Channel signaling for German 1TR6
e VN4 » D-Channel signaling for France VN3
e TPH = D-Channel signaling for Australia
o NTT » D-Channel signaling for Japan
Communications ¢ Ethernet
e ZC208
o V.35
B channel protocols » ZC208 accesses Internet with rates up to 128K.
Voice call protocols e Voice only call
»_Simultaneous voice and data calls supported
Rates = T.120 driver for MLP/HMLP,
* MLP/HMLP combination up to 128K
Data * Microsoft NetMeeting
 Built-in file transfer and messaging commands
* Far-end Camera control
BRI Interface + BRI Basic Rate S/T interface
Bonding Modes .

Mode 0:This mode provides initial parameter negotiation and Directory Number
exchange over the master channel, then reverts to data transmission without
delay equalization. This mode is useful when the calling endpoint requires
Directory Numbers, but the delay equalization is performed by some other
means.

» Mode 1: This mode supports user data rates that are multiples of the bearer
rates. It provides the user data rate with the full avaiiable bandwidth, but does
not provide an in-band monitoring function. The overhead octets are removed
after the call is phase aligned. Error conditions on one or more channels that

disturb overall system synchronization are not recognized automatically

Physical Specification

Specification | Dimension

PC

Weight e 45ibs.

Dimension » Desktop case with 6.5" (Height) x 16.5” (Width) x 16.25 (Depth) dimensions
Connections

Power connections Surge protected AC for device, monitor, and PTZ camera all in one
ISDN/Network 4 RJ-45 ISDN connections

Connections 1 RJ-45 Network connection

Peripheral Connections

4 pin din for S-video camera Input (Z360 board)
Two XLR for microphone connection (Z360 board)
3.5mm jack for speaker output connection (sound card)

* 9 pin D-sub tor for F of (cpm‘[ppnicati‘gqs port)m__

Environmental Requiremen =

Parameter Category Specification

Temperature ¢ Operating e 0Cto+40C
» Non-operating e -20Ct060C

Humidity s Qperating * 5% to 95% (No Condensation)
» Non-operating * 0% to 95% (No Condensation)
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Operating voliage

e 80-130V/180-204V

Typical AC power

e 200 watts

22




comStation Installation Guide

Index
assembling comStation .............c.cviiienncrern . 5 NETC o e e 17
ATM et an 19 PAL ..ottt 17
camera product specifications .............ccceeevveivenicnnnnnnn, 20
brand and model..........ccceeeeveecrriiiceeee e 17 ReCOVEIY DiSK....c.ceeveerivericiicecei vt seeeenens 17
far end control..........ccooeveeeicecci e 17 Safety Information..........cccccvvviinieccc e 4
COMMENTS ..ot sneenrreene 24 setting up the video configuration...........cccco......... 17
COMPOSIe VIdBO ... s 17 SPeCfiCAtions ... e 20
comStation S-ViIdBO .o 17,18
assSembling......cvveiiie e 5 technical specifications...........ccoeeveeeeevvrer v, 20
Recovery DisK.........cccocrveieiiiinnieion e 17 Type of comStation
comStation 512 ... 10 MOTBIS......cccoiieiiesreere et e 5
comStation Components..........cccceoveceevvceeeionnann, 14 Using the ATM TOO! ..o, 19
comStation IP ... 8 using the Recovery Disk ..........ccocevvvuicceevenrnn, 17
comStation V.35 ... 12 VId0 CONNECLO ...t cerens 17
configuring video format .........c.vvvcieir e s 17
VIdBO INPUL .ot 17 video input
connector COMPOSILE ..o e e 17
VIO .o e 17 CONTIGUIING.cvee et 17
Customer SUPPOrt ......c.c.ceeveeovecrireee e, 4 CONNBCION......ceireccire e ser et 17
document SVIdeO. ... e e 17
related to comStation..............ccovvieierceeeeeee. 4 video input CoNNECEON...........cccovvviiieeeee e 17
far end camera control ............ccecoeeieeeervivniensieeens 17 Video Setup Wizard ..........cccccoeivviiee oo 17
keyboard...............ccmi e 14 Zydacron
live VIHBO.......oviiiec e 18 Contacting Us ..o 24
main video Window ............ccooeecccvives e 18 name and address ......ccecevevvennienieen e 2
NBIWOTK ... et e e e e e 14 Zydacron Test Station.............ccovveeeeeeeeeeeieceee 4

23



comStation Installation Guide

Send Us Your Comments

We welcome your comments regarding this manual. If you have suggestions for improvements or find any
errors, please indicate the manual, chapter, section, and page number. Your input is valuable in improving our
documentation and our products.

You can send comments to us in the following ways:
E-mail — support@zydacron.com

FAX — 603-647-9470 Attn: Technical Publications
Postal Service

Zydacron, Inc.

Attn: Technical Publications
- 7 Perimeter Road

Manchester, NH 03103

USA
Name Title
Company Department

Mailing Address

Telephone Number E-mail Address
Book Title Version Number
Operating System Document Part Number:

1. Were you able to find the information you required?
Very Good Good Acceptable Poor Very Poor

2. How do you rate Zydacron’s manuals in comparison to other manuals you use?
Very Good Good Acceptable Poor Very Poor

3. Please rate Zydacron's manuals according to the following:

¢ Technical accuracy: Very Good Good Acceptable Poor Very Poor
s Ease of finding information: Very Good Good Acceptable Poor Very Poor
« Completeness: Very Good Good Acceptable Poor Very Poor
» Ease of reading information: Very Good Good Acceptable Poor VeryPoor

4. Comments:
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